
GUIDELINES FOR EXEGESIS ASSIGNMENTS

By
Dr. Mark Allen Hahlen and the Dallas Christian College Bible Department

WHAT IS AN EXEGETICAL PAPER?

Derived from a Greek verb meaning, “to lead out” or “to draw out,” the term “exegesis” refers to a careful, systematic study of Scripture undertaken to draw out the author’s original intended meaning for his audience. An exegetical paper, then, is a research paper that systematically explains the meaning of a biblical passage within its original setting. The writer of the paper analyzes how the biblical author’s choice of words and literary artistry created that meaning within the historical, cultural, and theological contexts of the biblical author and his original audience. 

COMPONENTS OF THE EXEGETICAL PAPER

Pre-Matter

	The first page of your paper should display in the upper left-hand corner an MLA header that lists your name, the course number and name, the instructor name, and either the due date of your assignment or a description of the assignment (e.g., Exegetical Paper). This header should appear inside the margins of the paper. Do not use the header function of your word processor to create it.
You should also provide a pagination header in the upper right-hand corner that shows your name and the page number.  Do use your word processor’s header function to create this automatically; do not attempt to create this header manually at each new page. (See “Appendix A: Formatting Your Paper” for a summary of format requirements and procedures.)
	If your instructor asks for a separate Thesis and Outline Page, it will comprise the first page of your paper. If he or she does not require a thesis and outline page, you should center your title two inches from the top of the page, that is one inch below the top margin, and begin with your introduction.
	Unless your instructor explicitly instructs you to do so, do not include a copy of your study text at the top of your paper, as do many sample papers you find in guidebooks and online.  These sample papers usually reflect seminary settings in which students are providing their own translation of the Hebrew or Greek text. Assume your reader has a Bible and can follow along in your discussion.

Introduction and Thesis (1/2 to 1 page)
	The introduction to the paper should begin with some sort of attention getter, a description of your interest in the text, or an explanation why the text would be significant for the reader. The introduction should lead into the thesis statement for the paper. Do not begin the introduction with the thesis statement; ramp up to it.  
The thesis statement announces, in one sentence, the “t’s” of the paper. It names the text, i.e., the explicit book, chapter, and verse(s) scripture reference for the passage covered in the paper. And, it summarizes the treatment, i.e., what you intend to demonstrate about the passage or topic. The thesis summarizes the understanding or position about the text to which the research has led you. It should answer the basic questions: “What did this text mean in its original setting?,” “What purpose did this text serve in its original setting?,” or “How did the author communicate his meaning or achieve his purposes?” That is, your thesis statement should state concisely the meaning and / or purpose of the biblical text and point to how the biblical author communicated that meaning or accomplished that purpose. Very strong thesis statements also point directly or indirectly to how you intend to develop your discussion.  (For more on thesis statements, see “Appendix B: Thesis Statements.”)
	If the instructor required a Thesis and Outline page, the thesis statement presented on that page should appear in the same form in the introduction of the paper.

Summary of the Text’s Historical Context (1 page)

	In this section of the paper, briefly present information concerning the author, the recipients, and the basic historical-cultural context of the biblical book in which your text appears. Avoid the temptation to give an extended biography of the writer. Assume the reader will know who Paul, Jeremiah, Peter, etc. were. Provide only biographical information and contextual information about the text’s author, the text’s original audience, and their world that the reader needs to know in order to understand the circumstances surrounding the text. 
	Keep this discussion concise and general, reserving extensive comments for footnotes or for those sections in the body of the paper where they will be most helpful. Bear in mind that you would provide here information that is background for the whole book or passage. Reserve for later information that relates directly to specific elements within the text.
	If there are debated points concerning the origins of the biblical book, consider providing a summary of the options and a brief statement of your conclusions in the body of the paper, but use footnotes to present or explain the more detailed points of debate.

Summary of the Text’s Literary Context (1/2 to 1 page)

	Describe briefly the setting of the study text within the larger book. Summarize the author’s flow of thought leading up to the text and flowing out of the text you are exegeting.  Identify those major themes in the book to which your text contributes.  

Genre and Structure of the Text (1/2 page)

Identify the genre or form of the passage. Give reasons why you identify its genre as you do. Describe the text’s structure either by presenting a formal outline of the passage or by describing its structure in paragraph form. 

Detailed Discussion of the Text (5 to 10 pages)

	The majority of your paper should analyze the meaning of the text and the means by which the author communicated that meaning. Beware of a compartmentalized approach in which you place all word studies in one section and discuss contextual elements, grammar, and the like in other isolated sections. Rather, you should bring to bear what you have learned from your research as you discuss a specific verse(s) or a specific concept in the text, whether that information entails historical background, grammatical analysis, word study, literary design, etc.   
	 Let the structure of your discussion arise naturally from the structure of the passage. While a verse-by-verse analysis is both natural and logical, there may be times for being more creative. For instance, you may want to trace themes, repeated words and ideas, etc. appearing throughout the text by starting at the beginning of the passage and tracing the theme, word, or idea through to the end before going on to trace another theme, repeated word or idea through the passage.   
	As you discuss the text, make sure you:
	a.  Synthesize what you have discovered from your own observation and reflection with
     what you have learned from your research sources.
	b.  Present evidence for assertions you make. This evidence should include logical
	     argumentation as well as explicit citation of biblical passages and sources that confirm 
     what you have asserted. Do not forget that the Bible is a source. So, if you quote, 
     paraphrase, or summarize biblical content or allude to biblical events, make sure 
     you provide the reader with the appropriate scripture references, either within the
     sentence structure itself or in parenthetical notes.
	c.  Interact critically with your sources. Summarize reasons why scholars adopt certain
     conclusions and the reasons why you accept or reject their arguments.
	d.  Do not merely quote a line or verse of biblical text and then offer random comments
     on that text. Instead, write natural sentences and paragraphs that flow together.
     Quotations of the biblical text should arise naturally within your discussion.
e.  Try to write concisely and clearly.  Scholarly writing need not be complicated and
     convoluted.
f.  Write as if your audience is a group of students on your grade level or a year or two
     above. Explain terms and concepts with which most undergraduate students would be 
     unfamiliar. 

Conclusion and Application (1/2 page) 

	Summarize what the reader should have learned from the previous discussion and how you have supported your thesis. Then, briefly present key applications you see arising from the text. What significance does this text and its central message have for the contemporary audience? Remember, however, that the paper is not intended to be a sermon, nor is space here adequate for a sermon. Here, you can touch only briefly on key points of application and significance for the contemporary reader. A sermon or lesson is a task for another day.  

Footnotes or Endnotes

	MLA style guidelines call for using in-text parenthetical notes to cite sources within the body of the paper. Use footnotes or endnotes only to provide additional, expanded content or comment that you want to share with the reader but would be extraneous to the flow of the paper. For example, you may want to provide a footnote that indicates the primary Bible translation you have used, notes that direct readers to sources containing fuller treatment of content you have summarized in the body of your paper, or notes that provide supplementary commentary or information that would be distracting if it appeared in the main text.  
	Use the footnote or endnote function (References tab in Word) to create footnotes or endnotes. Do NOT use the Footer function to create footnotes.

Bibliography of Sources Consulted

(Do not count bibliography pages toward fulfillment of the paper’s page length requirement.)

Components of the Exegetical Paper
	List alphabetically, in correct MLA format, the sources you used in your research.  Unless instructed to do otherwise, present a bibliography of sources consulted rather than a 
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The Exegetical Process
bibliography of sources cited. A bibliography of sources cited includes only those sources for which you have parenthetical notes within the body of the paper. A bibliography of sources consulted includes both those sources you cited in parenthetical notes inside the paper and those sources you consulted but did not cite within the paper. Do not include in your bibliography any sources you did not actually consult. In other words, do not include any source from which you did not actually read.



THE EXEGETICAL PROCESS[footnoteRef:1] [1:  This description is heavily indebted to the outline appearing in Jeannine K. Brown, Scripture as Communication (Baker Academic, 2007), pp. 275-280.] 


See the previous section of this guide for a description of the paper’s structure. The text below describes the process of exegesis that contributes to the research one conducts before writing the actual paper. It outlines areas of research you will need to perform as you study the biblical text you are exegeting. Note that these “steps” may not always progress cleanly from one to the next. Something you learn while engaging in a later step may lead you to re-evaluate and return to an earlier research step.

1. Reflect on your presuppositions and pre-understandings about the text.

Begin your study by reflecting on what you already know or think you know about the text. Spend a few moments reading the passage. Note those interpretations of the passage you have encountered before in sermons, lessons, books, websites, etc. which influence how you currently understand the text. Make sure to include those readings and understandings you currently reject as your research may change your mind, or it may clarify why you reject that reading.
List those biblical passages that serve as a sort of interpretive lens through which you currently understand the text. Identify those texts by scripture reference – not simply “that text about…” Use a Logos Bible search or an online Bible search to find the passage(s), if you do not know the reference(s). 
Make a list of any terms, words, or ideas in the text that seem “foreign” to you or whose meaning you just “sort of” know but have never really researched. 
Doing the exercises above will help you identify what you currently think about the passage. Next, pray that God will guide you in discovering what the biblical author intended you to think and understand about this passage. Your objective, as you move through the following guidelines, is to try to understand the passage and its message more clearly and correctly.

2. Compare translations of the passage.

You will want to study your passage in four or five different translations. Some of these translations should come from the more “literal” or formal equivalent end of the translation spectrum (e.g., New American Standard Bible [NASB]; English Standard Version [ESV]). Others should come from the middle of the spectrum (e.g., New International Version [NIV]; New Revised Standard Version [NRSV]; Christian Standard Bible [CSB]), and others from the more dynamic equivalent or functional equivalent end of the spectrum (Good News Bible [GNB]; Contemporary English Version [CEB]). 
Because Bible translators often must make interpretive decisions, translations represent a very basic form of commentary, and comparing them can help you better understand portions of the text. Also, major differences in translations may alert you to interpretive issues in the text that warrant further study. 

3. Identify the social-world context of the passage: its socio-historical, political, and
    religious settings

Identify the author, audience, date, and the purpose of the book in which the passage appears. Investigate the biblical book for its own clues about the author, original readers, and the circumstances of the book’s origins. Then, consult secondary sources such as Old Testament and New Testament introductions, Bible survey books, Bible dictionary and encyclopedia articles about the biblical book in which the passage appears, and those sections in commentaries that deal with these matters. The author and date for some biblical books may not be clear, but you may be able to determine what type of person wrote the book or in what type of time the book was written. 
Investigate historical, cultural, and theological issues that would inform a better and more full understanding of the text. This step involves seeking to enter the circumstances and thought patterns of both the author and the original recipients of this text.
Determine whether the author quoted or alluded to earlier biblical texts. Because earlier scripture influenced heavily the thought pattern and words of later biblical writers, you should determine whether a New Testament writer quoted or alluded to any Old Testament texts. You should then consider how those quotations now function in the New Testament text. Any text notes, study notes, and cross-references provided by the translation publishers may be helpful here.
Consider how the author of an Old Testament text might have built upon an earlier Old Testament text(s). Look for quotations or allusions to earlier OT texts or events. Again, text notes, study notes, and cross-references provided by translation publishers may prove valuable.

4. Identify the text’s genre or form.

Identify the literary forms (genres) appearing in the text. Bear in mind that there may be multiple genres at work in a given text. For example, a text in the Gospels may be narrative, but it also may be a parable or a miracle story. Likewise, a text from a prophetic book might be poetic, but could be classified more specifically as a judgment oracle. Identify the characteristic structures in these forms and consider the strategies and expectations for reading that the genre(s) sets up for the reader. Resources like Fee and Stuart, How to Read the Bible for All Its Worth; Robert Stein, Playing by the Rules: A Basic Guide to Interpreting the Bible; Leland Ryken, A Complete Guide of Literary Forms in the Bible; and Leland Ryken, Words of Delight provide quick primers on reading various biblical genres. 

5. Place the text within its literary context.

Read the entire biblical book in which your text appears to help you determine the contribution it makes to the larger book. If possible, read the book in a single sitting. Seek to discern the flow, structure, and overarching message of the book. If your study text is a psalm, read at least those psalms within the “book” in which the psalm appears (Psalms is divided into five “books”) and read other psalms of the same genre (e.g., lament; praise psalms; royal psalms).
Outline the book by looking for its natural divisions. These divisions will be signaled by repeated phrases, transitional phrases, and changes in subject matter. Give these sections a “title” or short summary. 
Examine how your passage relates to its immediate context. How does the passage connect to the subject matter, lines of thought, and themes within the book or within the major section of the book in which it appears? Are key words or phrases in the text repeated elsewhere in the book? How do the passages / verses that immediately precede and follow the text contribute to understanding the message and purpose of the passage?      

6. Carefully analyze the text using appropriate methods and tools.

	In this step, you will break down the text into its component parts, analyzing them and asking how their inclusion creates meaning. First, outline the passage, dividing it into its natural sections and summarizing the main idea of each section. Next, observe the passage’s construction, structure, and words. Identify repeated words, phrases, and ideas as well as any comparisons and contrasts the author makes. Study the grammar of the passage, paying close attention to verb tense, the subject of verbs, the objects of verbal action, adjectives and adverbs.
	Study the relationship and movement of ideas through the passage. For narratives, pay attention to the setting, characterization, dialogue, conflict, action, and the climax of the story. For poetic texts, examine the dynamics of parallelism, the use of metaphorical (figurative) language, and the use of imagery. For epistles, play close attention to the relationships among sentences, paragraphs, and ideas.
	Explore how the message of the study text contributes to the larger biblical-theological context. Identify where your text quotes or alludes to earlier biblical texts. Note the original context of the quoted text as well as the biblical-theological themes present in that source text.  Reflect on the connection(s) between the quoted text and its use in your text. Try to determine why the author used the quoted text. Was it to support a part of the argument? To evoke memories of a part of Israel’s story? To provide the reader a helpful analogy to understand a difficult concept? To stress continuity between some aspects of the New Testament and the Old Testament?
Use cross-reference tools and your own mental chain reference system to connect the study text to other biblical passages that address the same or similar topics. Read those passages within their individual contexts and ask how they clarify and illuminate the themes the study text addresses and how they illuminate elements within the passage.
	Identify and research key words and phrases. Choose words to study that are integral to the structure and meaning of the passage, that are thematically significant, and that seem to be theologically important. Trace how the author uses the word or phrase in the rest of the book as well as in other books he wrote. Trace how the word or phrase is used in the rest of scripture. 
	Remember that you should perform your word studies on the Hebrew or Greek lemma, not on their English translations. Use the Bible search and word study functions in Logos and/or Hebrew and Greek lexicons (dictionaries), concordances, and other word study resources to assist you in this task.
Consult exegetical commentaries and books about concepts in your passage to gain additional insights into your passage. Conduct this step later in your research process rather than earlier. You may be unable to comprehend or appreciate adequately the scholar’s comments if you have not previously wrestled with the text and have not already become familiar with the text’s context and words. Nor may you be able to evaluate adequately comments made by a scholar unless you have first become familiar with the wording of the text and its context. Use commentaries to engage their authors in intelligent dialogue about the passage, not to get quick, ready-made answers. 

7. Rethink your presuppositions and preunderstandings.

Have your initial ideas about the text changed or deepened? If so, how and why? Have your interactions with your research sources altered the way you understand this passage? If so, how and why? How has closely and prayerfully studying this passage transformed the way you think? How has it challenged you to change your thoughts and behavior? 

8. Summarize the key ideas of the text.

Attempt to capture in one or two sentences the main ideas of the passage. Cast this sentence in third person language that emphasizes the author’s meaning or the message in the text. For example: “Paul provides a model for ministry in 1 Thessalonians 2:5-11 by his use of three family metaphors: gentle as a mother, brothers in labor, and exhorting as a father” or “In Isaiah 56:1-8, the prophet plays off the exclusions to tabernacle and temple worship found in  Deuteronomy 23:1-8 to anticipate a day when Yahweh will gather to himself people from all nations.” This step will be a step toward shaping the thesis statement of your paper.



Appendix A: Formatting Your Paper
General Document Format
Many of the correct format settings for an MLA (and APA) paper are not the Microsoft Word default settings. You may need to adjust the settings for your paper.
 
Margins – Set margins for 1 inch all around. Use the Layout tab menu in in Microsoft Word to adjust margins. 

Margin Indentation – Set Indentation for 0 inches. Incorrect indentation may result in incorrect margins. Set Home > Paragraph > Indentation > Left & Right for 0 inches.

Font – Acceptable fonts are: Times New Roman, Courier New, Arial, Calibri, or Bookman Old Style. Use only 12 point font. Do not use decorative fonts.

Spacing – Double-space your paper. Because Word’s default setting for “Multiple” spacing is not the same thing as “Double spacing,” you may have to adjust the spacing settings in the Paragraph menu in the Home tab. (Click on the arrow in the lower right-hand corner of the Paragraph menu.) 

Alignment (a.k.a. Justification) – Set Alignment for left justification. Click on the arrow in the lower right-hand corner of the Paragraph menu in the Home tab. Under General, set Alignment for “Left,” not “Justified” or “Right.” Justified or right alignment causes uneven gaps between words in paragraphs.

Paragraph Indentation (Body of the Paper) – Indent the first line of paragraphs one half inch from the left margin. Use the Tab key as opposed to pushing the Space Bar five times. Alternatively, you may set Home > Paragraph > Indentation > Special for First Line – 0.5”. This will create a half inch indentation each time you hit “Enter.”

Hanging Indentation (Bibliography) – Bibliographic entries should use hanging indentation. In hanging indentation, the first line of the entry is flush against the left margin, but all other lines in the entry are indented a half inch to the right. Set Microsoft Word to do this automatically by setting your bibliography pages to Home > Paragraph > Indentation > Special > Hanging – 0.5”. 

Spacing Between Paragraphs – Set Home > Paragraph > Spacing > Before and After to 0 pt. If set for Auto, 8 pt, or anything other than 0 pt, Microsoft Word will add extra, incorrect space between paragraphs. 

Other Form and Style Considerations
 
MLA Header – The first page of your paper should display in the upper left-hand corner an MLA header that lists your name, the course number and name, the instructor name, and either the due date of your assignment or a description of the assignment (e.g., Exegetical Paper). This header should appear inside the margins of the paper. Do not use the header function of your word processor to create it.

Pagination Header – Use the “Header / Footer” function in your word processor to create a pagination header that appears at the top of each page. This header should include your last name followed by the page number. Do not try to create manually each page’s header. In Microsoft Word, go to the Insert tab and then select Header > Edit Header. Once your cursor is in the header space, click on the Home tab and click on the right alignment icon in the Paragraph menu. Type your last name and insert a space. Next, select Page Number > Current Position > Plain Number. Finally, click on the Close Header and Footer icon.

Spacing after punctuation – Leave one space after a period or other concluding punctuation mark, unless your instructor prefers two spaces. Whichever spacing you choose, attempt to be consistent throughout your paper. 
 
Punctuation and Parenthetical Notes – If there is a parenthetical note at the end of a sentence, the period goes after the parenthetical note. Place a comma after the parenthetical note. Place the parenthetical note after the quotation marks, not inside them.

Parenthetical Notes – Use in-text parenthetical notes to cite sources within the body of your paper. The standard form of a parenthetical note is to list the author’s last name followed immediately by the appropriate page number(s). Examples: (Charles 54) or (Lenoir 55-56)   

Citing Biblical Content – The Bible is a source, so you must cite it when you quote, paraphrase, summarize, or allude to biblical content. To cite biblical texts and content, provide the scripture reference in the sentence structure or in a parenthetical scripture reference. Avoid using awkwardly appended sentences to cite scripture.

Incorrect:  The church in Philippi had been founded by Paul, beginning with the conversion of Lydia and the Philippian jailer. This is found in Acts 16:11-40.

Correct:  The church in Philippi had been founded by Paul, beginning with the conversion of Lydia and the Philippian jailer (Acts 16:11-40).

Correct: Acts 16:11-40 records how the church in Philippi began with the conversion of Lydia and the Philippian jailer in response to Paul’s preaching. 

Chapter and Verse Numbers – Use numerals, not words, to designate specific chapters and verses. The “rule” about writing out numbers less than 100 does not apply in the case of chapter and verse numbers. 
Incorrect: Verse five contains three commands. 
Correct: Verse 5 contains three commands.

Creating and Numbering Footnotes or Endnotes – Place content notes at the bottom of the page (as footnotes) or at the end of the text (as endnotes). Number notes consecutively throughout the paper (i.e., do not have a new number 1 on each page). In general, place the note number at the end of the sentence or phrase to which its content refers. To create footnotes or endnotes in Microsoft Word, go to the References tab and select “Insert Footnote” or “Insert Endnote.” Do not use the Footer function.

Special Font for Emphasis – Use italics or underlining for emphasis, not bold.  

Special Font for Transliterated Words – Italicize or underline transliterated Hebrew and Greek words. Do not enclose them in quotation marks, unless the word is the title of a dictionary article in the bibliography.  
Example: 
Correct – The word translated “transgression” here is pesha’, a word signifying rebellion. 

Incorrect – The word translated “transgression” here is “pesha’,” a word signifying rebellion.

Section Headers – You may want to divide your paper into sections, corresponding to the major points and subpoints of your outline. One method for formatting section headers uses font style to distinguish major points from subpoints. Underline and bold major point titles. Italicize the first level of subpoint titles but use normal font for the second level of subpoint titles. Place all section headers alone at the left margin, with no additional text typed on the same line. 

Another method places Arabic numerals before the section or subsection title in the following sequence: 1., 1.1., 1.2., etc.; 2., 2.1., 2.2., etc.; 3., 3.1., 3.2., etc. Place all section headers alone at the left margin, with no additional text typed on the same line.

Writing Out and Abbreviating Bible Book Names -- MLA style guidelines call for writing out Bible book names in the body of the paper and abbreviating them only within parenthetical scripture references. See “Appendix C: Bible Book Abbreviations” for a list of standard MLA Bible book abbreviations. 

Use Arabic numerals (1, 2, 3), not Roman numerals (I, II, III) in Bible book names (example: correct = 2 Corinthians; incorrect = II Corinthians). The exception is when you are quoting a source that used Roman numerals. 

Capitalizing Pronouns Referring to God and Nouns Referring to “Divine” Things – Older English style called for capitalizing pronouns referring to God, Jesus Christ, and the Holy Spirit. Contemporary usage does not require this “reverential capitalization.” Lack of reverential capitalization does not demean God in any way. The Old Testament was written in Hebrew, a language that had no upper-case letters. While biblical Greek did have capital (upper-case) letters and lower-case letters, texts tended to be written in all caps or all lower-case letters – not with mixed case. So, it wasn’t an issue for the biblical writers. Many ancient and contemporary languages lack capacity to distinguish upper-case and lower-case letters. The key is to be consistent. If you capitalize one pronoun referring to God, make sure you capitalize them all.
	Another old English style guideline was to capitalize nouns and adjectives connected to deity (e.g., Holy, Redeemer, Church, Salvation). Contemporary English capitalizes words only if they are the names of specific people (David, Abraham) or specific places (e.g. Jerusalem, Antioch). Trying to capitalize things related to divinity creates inconsistent capitalization. For example, in one document, a writer might capitalize “holy” but not “glory.” Why? What’s the rationale? Contemporary usage has returned to a simple rule that is consistent and which does not dishonor God in any way.  


Appendix A: Formatting Your Paper

Appendix B: The Thesis Statement

The thesis statement lays down the controlling idea, boundaries, and goals of the paper. It reflects the position to which the research has led the writer. The thesis statement announces, in one sentence, the “t's” of the paper: its text, that is an explicit scripture reference for the passage covered in the paper, and its treatment, that is, what the writer intends to demonstrate about the passage or topic. 

The thesis statement should not be the first sentence of your paper. You should lead up to it in your introduction.

Examples

Paul provides a model for ministry in 1 Thessalonians 2:5-11 through his use of three family metaphors: gentle as a mother, brothers in labor, and exhorting as a father.

In Isaiah 54:1-8, the prophet uses patriarchal, nomadic, and marital imagery to describe the spread of salvation that will follow the work of the Servant of Yahweh.

Joshua 14:6-15 displays the faithfulness of Yahweh toward those who faithfully follow him.

The quotations of Deuteronomy 6:5 and Leviticus 19:18 in Matthew 22:34-40 foreshadow how Jesus will complete his mission: he will love the Father by giving his life for his neighbor, the world.
Appendix C: Bible Book Abbreviations

MLA allows for abbreviations of Bible books only within parenthetical notes. Write out the book name within the sentence. (The exception is when you are quoting an author who used an abbreviation.) You may use or omit the period after the abbreviation but be consistent.

	Old Testament (alpha order)

	1 Chronicles = 1 Chron
	Hosea = Hos
	Psalms = Ps

	2 Chronicles = 2 Chron
	Isaiah = Isa
	Ruth = Ruth

	1 Kings = 1 Kings
	Jeremiah = Jer
	Song of Songs = Song of Sg

	2 Kings = 2 Kings
	Job = Job
	Song of Solomon = Song of Sol

	1 Samuel = 1 Sam
	Joel = Joel
	Zechariah = Zec

	2 Samuel = 2 Sam
	Jonah = Jon
	Zephaniah = Zeph

	Amos = Amos
	Joshua = Josh
	

	Daniel = Dan
	Judges = Judg
	

	Deuteronomy = Deut
	Lamentations = Lam
	

	Ecclesiastes = Eccl
	Leviticus = Lev
	

	Esther = Esth
	Malachi = Mal
	

	Exodus = Exod
	Micah = Mic
	

	Ezekiel = Ezek
	Nahum = Nah
	

	Ezra = Ezra
	Nehemiah = Neh
	

	Genesis = Gen
	Numbers = Num
	

	Habakkuk = Hab
	Obadiah = Obad
	

	Haggai = Hag
	Proverbs = Prov
	


	New Testament (alpha order)

	1 Corinthians = 1 Cor
	Acts = Acts
	Philemon = Philem

	2 Corinthians = 2 Cor
	Colossians = Col
	Philippians = Phil

	1 John = 1 John
	Ephesians = Eph
	Revelation = Rev

	2 John = 2 John
	Galatians = Gal
	Romans = Rom

	3 John = 3 John
	Hebrews = Heb
	Titus = Tit

	1 Peter = 1 Pet
	James = Jas
	

	2 Peter = 2 Pet
	John = John
	

	1 Thessalonians = 1 Thess
	Jude = Jude
	

	2 Thessalonians = 2 Thess
	Luke = Luke
	

	1 Timothy = 1 Tim
	Mark = Mark
	

	2 Timothy = 2 Timothy
	Matthew = Matt
	



	Selected Apocrypha (alpha order)

	1 Esdras = 1 Esd
	Bel and the Dragon = Bel and Dr
	Song of the Three Children = Sg of 3 Childr

	2 Esdras = 2 Esd
	Ecclesiasticus = Ecclus
	Sirach = Sir

	1 Maccabees = 1 Macc
	Additions to Esther = Add to Esth
	Susanna = Sus

	2 Maccabees = 2 Macc
	Judith = Jth
	Tobit = Tob

	Baruch = Bar
	Prayer of Manasseh = Pr of Man
	Wisdom of Solomon = Wisd of Sol




Appendix B: The Thesis Statement
Appendix C: Bible Book Abbreviations

Exegetical Writing vs. Application Writing
In general, exegetical writing describes what an ancient author or text communicated and how that message was communicated. Application writing, on the other hand, describes the significance of that text for how the contemporary reader should act, think, or feel. 

[bookmark: _GoBack]To understand how you, the writer, would compose an exegetical versus an applicational text, you need to understand a set of grammatical concepts related to verbs and to pronouns. They are “first person,” “second person,” and “third person.” Study the chart below.

	Singular
	Plural

	1st person =   I, me, my
	1st person = we, us, our


	2nd person = you, your
	2nd person = you, your


	3rd person = he, him, his
      she, her, her
      it, its
	3rd person = they, them, their




Verb use may be classified as being 1st, 2nd, or 3rd person, based on the explicit or implied pronoun subject (doer) of the verb.
First Person Singular Verb
“I have built the temple for the Name of the LORD, the God of Israel” (1 Kings 8:20, NIV).

I have been impacted by this passage.

Second Person Singular Verb
“You are not the one to build the temple” (1 Kings 8:19, NIV)

[You] Beware of a divisive attitude.

Third Person Singular Verb
“The Lord [he] has kept the promise he made” (1 Kings 8:20, NIV).

Paul [he] uses three metaphors in these two verses.

Ruth [she] demonstrated hesed in her dealings with Naomi.

The passage [it] opens with a command.

First Person Plural Verb
“We have seen his star in the east” (Matt 1:2, NIV).

We have often come to worship in our comfortable church buildings oblivious of those suffering around us.

Second Person Plural Verb

But [you – more than one of you] keep a distance of about a thousand yards between you and the ark.

[You – more than one of you readers/ listeners] Strive to be content with what the Lord has blessed you.

Third Person Plural Verb

“The priests [they] took up the ark” (1 Kings 8:3).

The believers in Thessalonica [they] would have been familiar with the image of a king coming to his subjects for a royal visit.

A piece of writing may be characterized as being predominantly first person, second person, or third person, based on the preponderance of the verbs and pronouns used in the sentence, paragraph, essay, etc.  

An exegetical paper or other research paper should be predominantly third person as it describes what the writer [he] wrote, what the readers [they] would have been thinking as they wrote, what the text’s words and structure [they, it] are doing, and what the actors in the text [they] were doing or thinking. Reserve application writing for the conclusion and application portion of the paper. 

Application writing is predominantly first or second person because it is cast in terms of telling the reader or audience what I should do, what we should do, or what you should do. 

The writer of an exegesis can cast a biblical text which was originally cast in first person (e.g., 2 Corinthians 5:1-10) or second person (e.g., 2 Peter 3:14-15) by quoting the first and second person elements inside a paragraph describing the text or by using indirect quotation to recast the words in third person.  For example:

Examples of Exegetical Writing
Paul uses a nomadic metaphor to compare the believers’ present existence with their existence to come. He claims: “If the earthly tent we live in is destroyed, we have a building from God, an eternal house in heaven, not built by human hands” (2 Cor 5:1, NIV84).  
-Or-
Paul states that believers in Corinth await an “eternal house in heaven, not built by human hands” (NIV84) in contrast with their present weak mortal bodies (2 Cor 5:1).
Another example:
Peter affirms that knowledge and expectation of the second coming of Christ should encourage ethical behavior and holy living in believers (2 Peter 3:14-15).
-Or-
Peter reminds his readers that, in light of their expectation of Christ’s return, they should be found “by him at peace, without spot or blemish” (2 Peter 3:14, NRSV).    
Examples of Application Writing
Our lives here are difficult. It seems we are in constant battle with our mortal bodies. But our bodies are like a temporary tent. Paul reminds us that we await a glorious strong house in the heavens (2 Cor 5:1).
Many of you have many questions about the nature and timing of Christ’s return. But, there is something about which you should have no doubt concerning his return – what you should be doing in preparation for it. Peter tells us succinctly and clearly, “while you are waiting for these things, strive to be found by him at peace, without spot or blemish” (2 Peter 3:14, NRSV). And earlier, he exhorted us “to be … leading lives of holiness and godliness, waiting for and hastening the coming of the day of God” (2 Peter 3:11-12, NRSV).  
	Exegetical vs. Application Language
Some Distinctions

	Exegetical Language
	Application Language

	Focuses on the original meaning and purpose of the text for its author and original readers
	Focuses on the significance of the text for the contemporary reader

	Focuses on the world of the text
	Focuses on the world of the contemporary reader

	Uses descriptive language (i.e., describes and explains events and thoughts of people in biblical times) 

	Uses prescriptive language (i.e., describes how contemporary people should act in their lives in response to the biblical text and events)

	Is dominated by the 3rd person (he, she, it, they)
	Is dominated by the 1st person (I, we) or the second person (you)

	Focuses on what he / they did, said, thought, and felt
	Focuses on what I / we or on what you should do, say, think, and feel

	Explanation / Interpretation
	Application

	Except when quoting text that uses first person (I, we) and second person (you), it avoids first and second person. 
	Embraces the first person (I, we) and second person (you).
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